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End-User License Agreement (EULA)

This End-User License Agreement (EULA) represents the contractual conditions 
between you, the Licensee, and UVI, located 159 rue Amelot, 75011 Paris - France 
for the use of software, documentation and other materials created by UVI. 

You should not register, install or use UVI Products until the 
following license agreement is understood and accepted.

By using UVI Products, or allowing anyone else to do 
so, you are accepting this agreement. 

A- License Grant
1. UVI grants to you, subject to the following terms and conditions, the 
non-exclusive right to use each authorized copy of the Product.

2. UVI Product license are granted only to a single user. You 
may use this product on up to three separate computers or iLok 
Dongles, which shall be owned and used by you exclusively. 

3. Renting or lending the licensed Software to a third party is expressly forbidden. 

4. Except if otherwise stated within this EULA, Licensee may resell the software 
to a third party or transfer the software permanently. Request may be done using 
the ‘Transfer License’ feature in your iLok account, subject to a $25 fee per-license 
($50 maximum) by Pace. The serial number of the Product will be transferred to 
the third party by UVI, and  Licensee’s original registration will be deleted.

5. Resale or ownership transfer of individual products obtained in a bundle, or 
those used to upgrade or cross-grade to other products are not allowed.

6. UVI allows you to use any of the sounds and samples in the products 
you’ve purchased for commercial recordings without paying any 
additional license fees or providing source attribution to UVI.

7. This license expressly forbids resale or other distribution of the sounds and 
software included in the Product or their derivatives, either as they exist on disc, 
reformatted for use in another digital sampler, or mixed, combined, filtered, 
resynthesized or otherwise edited, for use as sounds, multi-sounds, samples, 
multi-samples, wavetables, programs or patches in a sampler, microchip or any 
hardware or software sample playback device. You cannot sell the Product content 
or give it away for use by others in their sampling or sample playback devices. 

8. In the event UVI terminates this agreement due to your breach, you agree to 
return the original and all other copies of the software and documentation to UVI.

9. UVI reserves all rights not expressly granted to herein.

B- License Activation
1. In order to use UVI Products it is required that you authorize them by 
registering your Serial Number on uvi.net/register, have a free iLok account 
(not necessarily a dongle) and install the free iLok License Manager (done 
automatically by UVI Workstation and Falcon installers). It is impossible 
to use UVI Products if they are not registered and authorized.

2. During authorization you will need to enter your name, email address and 
postal address which will be stored in the UVI database. UVI uses a secure SSL 
connection with 128-bit-encryption that meets current security standards 
to transmit your data over the web. For further information about UVI’s 
handling of personal data please see: https://www.uvi.net/privacy-policy

3. The UVI Product license allows up to 3 simultaneous activations on any 
combination of iLok dongles and computers. Activations can be moved 
between devices at anytime through the iLok License Manager.

C- Protection of Software
You agree to take all reasonable steps to protect the Product and any accompanying 
documentation from unauthorized copying or use. You agree not to modify the 
Product to circumvent any method or means adopted or implemented by UVI to 
protect against or discourage the unlicensed use or copying of the Product.

D- Ownership
Ownership of, and title to, the enclosed digitally recorded 
sounds (including any copies) are held by UVI.
Copies are provided to you only to enable you to exercise your rights under the license.

E- Term
This agreement is effective from the date you open this package, and will remain in 
full force until termination. This agreement will terminate if you break any of the terms 
or conditions of this agreement. Upon termination you agree to return to UVI all copies 
of this product and accompanying documentation and destroy any other copies made.

F- Restrictions
Except as expressly authorized in this agreement, you may not 
rent, lease, sub-license, distribute, copy, reproduce, display, modify 
or timeshare the enclosed Product or documentation. 

G- NFR Serials and Free Products
UVI Products serial numbers labeled as “NFR” (Not For Resale) shall only be 
used for demonstration, testing and evaluation purposes. NFR Products may 
not be used for commercial purposes, and may not be resold or transferred.
They are not eligible for license recovery and are exempt from update, 
upgrade or crossgrade offers, and cannot be purchased with or exchanged for 
vouchers. Furthermore, as an owner of an NFR Product, you are not entitled 
to promotions available for the commercial version of the Product.

H- No Support Obligation
UVI will make its best effort to support you in the event of technical difficulty with a 
UVI Product. However, UVI is not obligated to furnish or make available to you any 
additional information, software, technical information, know-how, or support.

I- Specifications and System Requirements
All technical specifications of UVI Products provided are intended to be estimates 
or approximations. Due to numerous variables no guarantees of compatibility 
or performance can be made. All such specifications shall be in writing.
End-User is solely responsible for, prior to purchase, ensuring that End-User’s 
devices are compatible and meet the system requirements for UVI Products, 
and that the applicable UVI Products meet End-User’s requirements.

This EULA is governed by the laws of France.

 

©2017 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.

http://www.uvi.net/
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Cameo
Phase Distortion Suite

For us at UVI the CZ series from Casio is a longstanding favorite. 

When we approached the Cameo project we wanted to do 

something special that not only highlights the amazing sounds 

of these classic synths but that offers something new to our 

fellow CZ aficionados.

We began with a number of fully-serviced classics, including 

the Casio CZ1, CZ101, CZ1000, CZ2300S, CZ3000 and CZ5000, 

and ended up with 3 instruments—each with a different 

approach, unique sonic character and inspiration. 

CAMEO CZ

Cameo CZ incorporates a huge library of custom patches 

designed on the original hardware. An exposition of the 

rich diversity of timbres possible through phase distortion 

synthesis, sounds range from complex digital tones to thick 

and remarkably analog-sounding basses and leads. Cameo CZ 

provides an incredibly deep sample library, including variations 

with and without the unique Chorus effect of the flagship CZ1.

CAMEO CX
Cameo CX is a dual-layer instrument with a large catalog 

of sounds and raw waveforms captured directly from the 

hardware instruments. A hybrid methodology implores these 

raw waves as the basis for sound design within a modern digital 

environment, resulting in a wide variety of tones covering 

everything from vintage-inspired to digital bliss. Explore the 

factory presets or design your own sounds from scratch with 

the raw waveforms.

CAMEO CM
Cameo CM is our own modern inspiration of the phase distortion 

sound. Another dual-layer instrument, but this time utilizing 

the Wavetable oscillator and DSP shaping tools from Falcon. 

Cameo CM isn’t sample-based in the sense of the CZ and CX, 

rather it’s aimed at achieving wholly new and unique sounds 

using the capable architecture of the UVI Engine. Explore a 

range of high-quality presets or design your own sounds with a 

full compliment of synthesis tools and built-in effects.

Whether you’re a fan of classic ‘80s synth sounds, a phase 

distortion buff, or just looking to expand your palette of go-to 

sounds, Cameo delivers a treasure of new and delightful sounds 

with the unmistakable character of some of our favorite synths.

Minimum System Requirements
• UVI Workstation 2.6+ or Falcon 1.0.6+

• 9.2GB of disk space

For more information on the installation process, please refer to 

the document: Soundbank Installation Guide

Introduction

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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Cameo CZ - Edit Page

Amp

Noise

Effects

Globals + Page

Filter

Modwheel

1

2

4

3

6

5

1  Globals + Page
» Mono

Disables polyphony if active

» Arp

Toggle built-in arpeggiator on/off 

[additional controls available in UVIWS/

MF arp page]

» Edit

Sets the UI to the Edit page

» Mod

Sets the UI to the Mod page

2  Filter
» ADSR

Typical envelope controls for the filter

» Vel Sens

Adjust the filter velocity sensitivity

» Depth

Depth of the filters EG

» Cutoff Freq

Filter cutoff frequency

» Resonance

Filter resonance amount

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

3  Amp
» ADSR

Typical envelope controls for the amp

» Vel Sens

Adjust the amp velocity sensistivity

» Vel > Atk

Remaps Attack to Note Velocity

4  Modwheel
This section provides a quick way to 

map common controls to your MIDI 

keyboards modwheel

» Vibrato

Speed of the vibrato (free)

» Tremolo

Speed of the tremolo (sync)

» Filter

Cutoff frequency of the Filter

5  Effects
» Drive

Adjust drive value

» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

6  Noise
» Amount

Adjust noise mix amount

» White/Pink

Select white or pink noise types

The UI is divided into two pages; [Edit] and [Mod]. Main controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. Clicking the 
[Mod] button at the top of the interface reveals the second page of controls, where you can access the LFO and Step Modulator. Presets are accessible 
directly through the browser in UVI Workstation/Falcon.

http://www.uvi.net/
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Cameo CZ - Edit Page

Stereo

Pitch

7

8

7  Stereo
» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (in ALT and UNI 

modes only)

» Detune

Detunes the unison layers (UNI mode 

only)

» Mode - Off

Sets the stereo mode to OFF 

(monophonic)

» Mode - Alt

Sets the stereo mode to ALT; stereo 

position alternates L/R every note, width 

controlled by [SPREAD]

» Mode - Uni

Sets the stereo mode to UNI; layers 

multiple samples and augments them for 

increased stereo presence, modify with 

[COLOR] and [DETUNE]

» Mode - Chorus

Activates hardware Chorus layer

8  Pitch
» Depth

Sets the depth of portamento [Poly]

» Time

Sets the glide time for both modes

http://www.uvi.net/
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Cameo CZ - Mod Page

LFO

Step Modulator

1

2

1  LFO
» Sync

Toggle LFO sync to host tempo

» Shape

Select the LFO waveform: Sine, Square, 

Triangle or Sample & Hold (random)

» Speed

Set the LFO speed

» EG Depth

Set the depth of the LFO envelope

» Attack

Set the LFO envelope attack time

» Decay

Set the LFO envelope decay time

» > Pitch

Set the pitch modulation amount

» > Drive

Set the drive modulation amount

» > Volume

Set the volume modulation amount

» > Filter

Set the filter modulation amount

2  Step Modulator
» Res

Set the step speed/resolution

» Steps

Set the number of steps to playback

» Delay

Set the initial delay time

» Rise

Set the time to activate smooth

» Smooth

Interpolates sub-step values for a 

smooth modulation

» > Volume

Set the volume modulation amount

» > Filter

Set the filter modulation amount

» Step Value

Set the per-step value (draw with mouse, 

double-click to enter explicit values) 

  Saving Presets
» UVI Workstation

1. Click the [Multimode] button in the 

main toolbar

2. Click the [Wrench] icon

3. Select ‘Save Multi’

» Falcon

1. Click the [Wrench] icon and save as a 

Multi (all parts) or as a Program [single]

Settings for both UVI Workstation and 

Falcon will be saved automatically with 

your project if you’re working within a 

DAW.

http://www.uvi.net/
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Cameo CZ - Preset List

Arp:
Chords
CZ World
Elec Arp One
Extreme Kev
Fast Arp Wheel
Gimme Da Bass
Modular Death
One Note Mallet
Pop Cornus
Saturnox
Space Caroussel
Sweep Arp
The Champion
X Delirium

Bass:
Cosmo Jump
Elec Bass 1
Elec Bass 2
Filter Wheeling
Fretless Watch
Fuzz Wheel Bass
ImaginaCzion 1
ImaginaCzion 2
More than Analog
Organ Bass
Phat CZ Analog
Plastic Bass
Reso Bass
Saturn Bass
Slap Bass
Super Phase
Synth Chorus Bass
Whale Siren

Bells-Mallet:
Afro Perc 1
Afro Perc 2
Balaphonic 1
Balaphonic 2
Balaphonic 3
Bellisimax
Bells
Carillon
Conga
Cosmo Bells
CZ Fantasia 1
CZ Fantasia 2
Drop Pop
FX Bells
Gloken
Hybrid Christmass
Like a Bell
Mallet Log
Marie Pad Bell
Marimba

Metallic Sound
Music Box
MusiCZ Box 1
MusiCZ Box 2
Old Vibes
Phase Dist Bells
Rare Beauty Bell
Steel Drum
Trop Bell
Xylecho

FX:
Big Ben
Cosmo Timpani
Enigmatic
FX Mallet
It is Bomb BB
Mad Kevin
Synth Drums

Keys:
Barbarie
Cosmo Harpsichord
CzP Piano
Dark CZ Keys
Deluxe Clav
Dynosauroad
Funky Clavi 1
Funky Clavi 2
Grand CZ
Harpsichord
Honky Tonk Chorus
Hybrid Wurlicoustic
HybriDream 1
HybriDream 2
Impressive Road 1
Impressive Road 2
Jazz Organ
Keys Brid
LA Chapelle 1
LA Chapelle 2
LA Chapelle
Large Chorused
Lounge Electric
Magikeys
Mellow Phase Keys
Old Organ
On the Road again
Organ Attack
Phase Clave
Piano 1
Piano 2
Piano Compact 1
Piano Compact 2
Pipe Organ
Pluckeyboard
Pure Tines

Reed Tines
Short Crystal Keys
Slap Clavinet
So Nineties
Soft Pop Organ
Split Harpsy
Stack Organ
Tiny Wurli
Toy Piano
Tremellow Keys

Leads:
Cosmopolead
Curtis Z
CZ Hard Lead
Dirty Brassy
Duck Dance
Elastinalog
EMW Solo
Funky Fresh
Fuzz Mosquito 1
Fuzz Mosquito 2
Gritty Five
Larsenor Mittal
Lead Her Brass
Like a Bird
Nanolead
Patchoulead
Perc Whistle
Picolead
Plastic Solo
Smooth Pop
Steady Solo
Synth Lead 1
Synth Lead 2
Synth Lead 3
Synth Saxo
Take Five
Whistle

Misc:
Acc Guitar
Almost Harp
CZ Trumpet
Flute
Harp
Hybrid Fretted
Jazz Guitar
Koto
Medieval Picollo
Orchestral Flutes
Sitar Long Bend
Slap Funk
StatoCZphere 1
StatoCZphere 2
StatoCZphere 3
Steevy Cosmo

Pad-Strings:
Cosmopoly 1
Cosmopoly 2
CZ Choirs
CZ Hard Pad
Express Machine
Fast Strings
Magic Way
Pad Machine
PD Strings
Phase Orchestra
Poly Strings
Solina Z
Stack Hato
Strings 1
Strings 2
Strings 3
Synth Strings
Tron Mello
Voice 1
Voice 2

Polysynth:
Cosmophonic
Doctor Phase
Driver
Eighties Pluckeys
Factor Hard
Funky Stab
Gritty Poly
Love Poly
Plastic Pluck
Poly Funky
Poly Tanger
PolyMagination
Short Five
Short Pluck
Soft Pluck
Square Keys
Stab Five
Wavetabling

Sweeps:
CZweep Classic
Sweep Sound 1
Sweep Sound 2
Ultra Sweep

Synth Brass:
Analog Pure
Attitude
Brass 1
Brass 2
Brass 3
BrasSquare
Chill Brass
Cosmobie One

CZ Her Brass
Da Brass
Ensemble
Fatanalog
Fun Brass
Majestic Brass
Metronomy 1
Metronomy 2
Orchestra
Soft Attack
TrumpetZ
Versoftile
Xpander Brass

Waveforms:
Wave-01
Wave-02
Wave-03
Wave-04
Wave-05
Wave-06
Wave-07
Wave-08
Wave-09
Wave-10
Wave-11
Wave-12
Wave-13
Wave-14
Wave-15
Wave-16
Wave-17
Wave-18
Wave-19
Wave-20
Wave-21
Wave-22
Wave-23
Wave-24
Wave-25
Wave-26
Wave-27
Wave-28
Wave-29
Wave-30
Wave-31
Wave-32
Wave-33

http://www.uvi.net/


9

Cameo CX - Edit Page

Layer Globasl

Presets

Layer Edit

Master Gain

Amplitude

Drive

Pitch

Pages

4

7

8

6

23

1

5

The UI is divided into three pages; [Edit], [Mod] and [Arp]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. 
Clicking the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. The final [Arp] page 
presents an independent arpeggiator for each layer.

Main

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, Mod or Arp

3  Layer Globals
» On/Off Toggle

Turn layers A and B on or off

» Volume

Adjust the Volume of each layer

» Pan

Adjust the Pan of each layer

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Layer Edit
» Wave Menu

Choose the wave category in the first row 

and the wave in the second

» Edit 1 | Edit 2 | Edit All

Choose to edit layers A or B seperately or 

simultaneously

6  Pitch
» Octave

Adjust the pitch in Octaves

» Semi

Adjust the pitch in Semitones

» Depth

Adjust the Portamento depth

» Time

Set the Glide time

» Mono

Toggle between Mono and Poly voicing

7  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» Velocity

Sets all incoming notes to max velocity

8  Drive
» On/Off Switch

» Amount

Sets the amount of drive

http://www.uvi.net/
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Cameo CX - Edit Page

Stereo

Filter

Effects

Modwheel

10

11

12

9

Basic Controls (continued)

9  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: setunes layers

10  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» EG Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity

Adjust the Velocity > Filter sensistivity

» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

11  Effects
» Power/Amount

Choose from Phaser, Delay, Reverb and 

Chorus (additional controls available in 

the Effects page of UVIWS and Falcon)

12  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

http://www.uvi.net/
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Cameo CX - Mod Page

Sync

Step Sequencer

Waveforms

LFO Controls

Mod Routing

Mod Routing

Params

4

7

6

1

5

2

3

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

6  Params
» Grid

Change the sequencers step length

» Steps

Change the amount of steps for the 

sequencer to play

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

7  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://www.uvi.net/
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Cameo CX - Arp Page

Step Indicator

Step Editor

Tie

Layer A > Layer B

Arp On/Off

Steps

Gate

Octave

Rate

Mode

5

6

8

10

7

1

2

3

4

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
16-step sequencer; affects Velocity

3  Tie
When active, step inherets Velocity from 

the previous step

4  Layer 1 > Layer 2
When active, Arpeggiator 1 affects 

both layer A and layer B (whereas 

when disabled each Arp modifies its 

corresponding layer only)

5  Arp On/Off
Toggle the Arpeggiator On/Off

6  Steps
Change the step length

7  Mode
Select Up, Down, or Up and Down

8  Gate
Change the step length (knob value 

ranges from zero to the tracks Resolution 

setting)

9  Rate
Sets the Arpeggiators step length

10  Octave
Set the pitch range of the Arpeggiator 

in Octaves

9

http://www.uvi.net/
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Cameo CX - Preset List

CATEGORY
00-Init

AR-Analog CZ

AR-Bass to Arp

AR-Fantasiarp

AR-Golden Age

AR-Magician

AR-Mystic Lounge

AR-Pad Arp J

AR-Plastic Age

AR-Pluck and Soft

AR-Ritournelle

AR-Sonic Village

AR-Tangerine Wheel

AR-Time Backup

AR-Vox Portal

AR-Wheel Berimbau

AR-World Box

BL-Bell Friend

BL-Christ Mess

BL-Cosmo Koto

BL-Expression

BL-Gimmick

BL-Horizone

BL-Hybrid Case

BL-Interfered

BL-Log Mall

BL-Mallet Hit B

BL-Meditation

BL-Mixed Bells 1

BL-Mixed Bells 2

BL-Old Field

BL-Papillon

BL-Plastic Bell

BL-Rome Antique

BL-Space Glass

BL-Toy Oisac

BL-Ultra Wet

BR-BasiCZ

BR-Brasstring

BR-Cindy Looper

BR-Digital Orchestra

BR-Massive Brass

BR-Mosquito Brass

BR-Peggio

BR-Poly Solo

BR-Simple One

BR-Stack Brass

BR-Wheel Morph

BS-Co Jones

BS-Da Cosmos

BS-Eighties Pattern

BS-Hendrix Sub

BS-Log A Rythm

BS-Orchestral Big

BS-Raw Beef

BS-Skriwheel

BS-Sub Whale

BS-Supra Funk

BS-Wha Sub

CH-Forest Calm

CH-Joly J

CH-Light Step

CH-Matador

CH-Mayhem Control

CH-Reggae Tone

CH-Road Movie

CH-Slow Motion 1

CH-Slow Motion 2

CH-Top Hard Wheel 1

CH-Top Hard Wheel 2

CH-Under Control

KB-Big CZ Keys

KB-CameOrgan

KB-De Barbarie

KB-Eight Bit

KB-FunkHybrid

KB-Lunharpsichord

KB-Marimkeys

KB-One More Time

KB-Pure Tines

KB-Sweep and Chips

KB-The Fifth Organ

KB-Wave Keys

KB-Wheel Fantasia

LD-Dualead

LD-Funkadelead

LD-Guitarinx

LD-No Glide

LD-P Funk CZ

LD-Phase Pop Corn

LD-Scie Digitale

LD-Sheet Corea

LD-Simple Lead

LD-Solo Raw

LD-Space Flute

LD-Toxicosmos

LD-Wheel Xpression

PD-Air France

PD-Analog Vision

PD-Baurealis

PD-Broken Pad

PD-Cosmo Pad

PD-Crystal Lounge

PD-Dreaming

PD-FX Pad

PD-Glass of Star

PD-Horse Wheel

PD-Melocoton

PD-New Agent

PD-Polaire

PD-Smoothie

PD-Superbe

PD-Under Terra

PD-Wheel Manipulation

PD-Zen Bell

PL-Cosmo Delirium

PL-Crazy Poly Wheely

PL-Dirty Diana

PL-Drop Box

PL-Empire Strat

PL-Equation

PL-Intense City

PL-Magical Flute

PL-Poly Tess

PL-Saw Wheel

PL-Synth Pole

PL-Tosca Link

PL-Weirdome

PL-Yanni Chord E

ST-Cameo Strings

ST-Cosmotron

ST-Le Grand Blue

ST-Orchestral Phase

ST-Solinox

ST-Stack Strings

ST-TV Show 80s

ST-War After

SW-Gonzasweep

SW-On Wheel

SW-PortamentHigh

SW-Scary

SW-So Classic Z

SW-Template

http://www.uvi.net/
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Cameo CM - Edit Page

Presets

Amplitude

Phase Distortion

Edit

Layer Globals

Master Gain

Pitch

Pages

4

6

2

1

7

8

5

3

Main Section

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, FX or Mod

3  Layer Globals
» On/Off Toggle

Turn layers A and B on or off

» Volume

Adjust the Volume of each layer

» Pan

Adjust the Pan of each layer

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Edit
» A | B | AB

Choose to edit layers A or B seperately or 

simultaneously

» Wave Menu

Choose a waveform

6  Pitch
» Semi

Adjust the pitch in Semitoness

» Depth

Adjust the Portamento depth

» Mono

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Octave

Adjust the pitch in Octaves

7  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity

Sets all incoming notes to max velocity

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

8  Phase Distortion
Change the amount of phase distortion

http://www.uvi.net/
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Cameo CM - Edit Page

Stereo

Filter

Modwheel

10

11

9

Basic Controls (continued)

9  Stereo
» Unison Voices

Change the number of unison voices

» Spread

Change the stereo width

» Detune

UNI Mode Only: detunes voices

» Alt

Alternate pan mode

10  Filter
» Mode

Choose Filter mode; Off, Low Pass, Band 

Pass, or High Pass

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» Offset

Adjust the amount of frequency offset

» Drive

Adjust the amount of drive

» Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity

Adjust the Velocity > Filter sensistivity

» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

11  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

http://www.uvi.net/
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Cameo CM - FX Page

Chorus

Phaser

Delay

Reverb

1

2

3

4

1  Chorus
» On / Off

» Filter

Adjust the filter frequency

» Dry

Adjust the dry signal amount

» Wet

Adjust the wet signal amount

2  Phaser
» On / Off

» Speed

Adjust the phasers LFO speed

» Feedback

Adjust the phasers feedback amount

» Depth

Adjust the phasers filter depth

3  Delay
» On / Off

» Time

Adjust the delay time

» Feedback

Adjust the delay feedback amount

» Mix

Adjust the effect mix amount

4  Reverb
» On / Off

» Size

Adjust the room size

» Time

Adjust the decay time

» Lo

Adjust the low freq decay multiplier

» Hi

Adjust the hi freq decay multiplier

» Mix

Adjust the effect mix amount

http://www.uvi.net/
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Cameo CM - Mod Page

Sync

Step Sequencer

Waveforms

LFO Controls

Mod Routing

Mod Routing

Params

4

7

6

1

5

2

3

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

6  Params
» Rate

Change the sequencers step length

» Steps

Change the amount of steps for the 

sequencer to play

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

7  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://www.uvi.net/
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Cameo CM - Preset List

CATEGORY
00-Init

BL-Emphasis

BL-Mario Square

BL-Mixity

BL-Model Bell

BL-Simple Beauty

BL-Standard Bell

BL-Synth Bell

BL-Vick Celesta

BR-Los Vangelis

BS-A Big one

BS-Grainy Subby

BS-Larsen Wheel

BS-Offset Funk

BS-Phat Clic

BS-Raw Saw 1

BS-Raw Saw 2

BS-Sub Wobble Wheel

BS-Wheel Me Step

BS-Zapp Sub

FX-Cyber Dolfin

FX-Heroes

FX-Sonar Space

FX-Sub Liminal

FX-The Wizzard

FX-War Star

KB-Claviwheel

KB-CreatiWet

KB-Ethereal Keys

KB-Halorgan

KB-Keycoustic

KB-Kooba Kooba

KB-Like a Bell

KB-Step a Toy

LD-A Level

LD-Change Da Wave

LD-Dirty One

LD-Dream Land

LD-Fuzz Wheel

LD-LaCie Musicale

LD-Mamouth

LD-Pepo Nekor

LD-Simplead

LD-Solo Podo

LD-White Street

PD-Dark Angel

PD-Dirty One

PD-Dirty Wheel

PD-Evolute

PD-Heroine

PD-Octave Strings

PD-Ominous Digital

PD-Ominous Vox

PD-Portamentos

PD-Revolution

PD-Soli Paddi

PD-StePad

PD-Tremooloo

PL-Basic Poly

PL-Double Stack

PL-Fairlight Vibe

PL-Gentle Pluck

PL-Helicopwheel

PL-Hive and Cesar

PL-I Am Mod

PL-LFO Rice On

PL-Majestic Pluck

PL-Mishok Wheel

PL-Moore Uzi

PL-Pizzi Catho

PL-Pure Madness

PL-Short Stab

PL-Skritonium

PL-Step Filter Wheel

PL-Step Folie

ST-Analog Strings

SW-All in Camon

SW-Astral Risk

SW-Big Sweep

SW-Long Island

SW-Simple Sweep HP

http://www.uvi.net/
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

Soundbank Installation Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . installing_uvi_soundbanks_en.pdf 

UVI Workstation User Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uviworkstation_user_guide_en.pdf 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 

http://www.uvi.net/
http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/ilm.html
https://www.ilok.com/#!faq
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